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Introduction 

Roll-Up III belongs to a class of computer input devices called graphic tablets, or 

digitizers.  A digitizer is an electronic tablet work surface.  The position of a transducer, a 

handheld cursor or stylus, on the work surface of the Roll-Up III is converted – digitized – 

into data for computer processing.  Data output from the Roll-Up III digitizer is in the form 

of an X/Y coordinate pair that pinpoints the location of the transducer on the tablet 

surface.  The Roll-Up III is a specialized graphic digitizer that is specifically designed to be 

portable, so it can be taken to the job site. 

NOTE: Roll-Up III uses an electrostatic technology for digitizing with blueprints and 

nonconductive inks.  If you are using black line drawings with conductive ink, the Super L 

Series Digitizers are more appropriate. 

Roll-Up III works with many graphic, CAD and estimating applications.  These applications 

use the digitized data from the Roll-Up III to: 

 Determine the dimensions of objects on drawings and blueprints 

 Move the pointer on the display screen 

 Create and manipulate objects in a graphic composition 

 Trace a drawing, or other source material to create an image on the display screen 

 Select commands or functions from an application menu placed on the tablet 

surface 

 Select items from a pull-down menu on the display screen 

In order to send data from the Roll-Up III to your digitizing application, the digitizer must be 

physically connected to your computer, and it must be able to transmit the data in such a 

way that the digitizing application recognizes and understands it.  Before you set up the 

Roll-Up III, you should determine: 

 The requirements of the digitizing software application being used 

 Whether your digitizing application requires software drivers to communicate with 

the Roll-Up III 

 Hardware communications connection (Serial or USB) you will be using between 

the Roll-Up III and the computer 
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Parts Checklist 

 Roll-Up III digitizing tablet 
 Transducer (stylus/pen, 4-button or 

16-button cursor) 
 USB cable 

 CD-ROM with Windows Drivers and 

user’s manual 

 Accessory case* 

 Cardboard tube, insert and end 

caps* 

*Do Not Discard 

 

Optional Equipment 

 Computer interface cable with 9-pin 

connector for serial connection 

 Power supply – required only for 

serial installations 

 Deluxe travel bag 

 

 

What You Will Need to Use Roll-Up III 

 A computer running a Windows operating system with USB port, or an RS-232C 

serial communication port.  (Serial signal levels must conform to EIA RS-232C 

specifications.) 

 Application software that accepts digitizer input via the Wintab API, or application 

software that directly accepts digitizer input via the computer’s RS-232C serial port. 

 

Setting Up Your Roll-Up III 

The instructions below describe how to set up your Roll-Up III.  Before you begin, please 

take a moment to fill out and mail the Warranty Registration Card or register your digitizer 

on our website at http://www.gtcocalcomp.com/warranty-information. 

Software Configuration 

Software drivers provide the communication bridge between your digitizing software 

application and the Roll-Up III.  You should install only the drivers necessary for the Roll-Up 

III to work with your application software.  The GTCO CalComp by Turning Technologies-

http://www.gtcocalcomp.com/warranty-information
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supplied TabletWorks CD supports reduced functionality Wintab and TabCon-compatible 

applications.  If you are not sure which drivers are required, check the Table 1 section of 

this manual or consult with your application vendor.  A driver does not need to be installed 

if you are using Roll-Up III with GTCO CalComp by Turning Technologies QuikRuler III™. 

Configuring Non-Wintab Applications  

Many application programs provide configuration information for specific digitizers.  If the 

Roll-Up III digitizer is not listed, you can use the configuration for GTCO CalComp by 

Turning Technologies Digi-Pad Type 5 or Type 5A (T5/T5A), Roll-Up II, CalComp 9100/9500, 

or Summagraphics Microgrid III or ID Series. 

Installing the TabletWorks Driver 

Insert the CD into the CD-ROM drive on your computer.  The installer will autoload.  If it 

does not, click on the Start button on the Windows Task Bar and select Run from the 

menu.  Type X:\setup.exe (X represents the CD drive letter).  Follow the onscreen prompts 

to complete the installation. 

A TabletWorks icon  will display in the System Tray on the Windows Task Bar.  Right 

click on the icon to display the TabletWorks Menu, which provides access to all the 

TabletWorks features. 

Hardware Configuration 

When you use the USB interface, no data output configuration is required.  However, when 

you choose the optional serial interface, the Roll-Up III must be configured to send data in a 

format that is compatible with the application software.  Different applications have 

different requirements when interacting with a digitizer.  Roll-Up III is designed to provide 

the appropriate serial requirements for a wide variety of graphic, CAD and estimating 

applications using a simple code system.  The SuperSet Menu on the surface of the Roll-Up 

III is used to enter the appropriate code for the software being used.  A table in the Using 

the SuperSet Menu section of this manual lists the SuperSet Codes for a wide variety of 

applications. 

Determine if you have not already, which communication connection you will be using – 

USB or Serial. 

NOTE: Conductive materials, inks or electronic devices on, under or near the Roll-Up III can 

cause improper operation.  See the Troubleshooting section for more details. 
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1. Select a large, flat, nonmetal 

surface on which to place the 

Roll-Up III.  Clear all items from 

the surface. 

2. Remove the Roll-Up III from its 

cardboard tube container and 

unroll it on the selected 

surface. 

3. Connect the transducer – 

cursor or stylus – to the 

appropriate jack on the 

digitizer’s Connector Panel.  The 

connector is keyed and will fit 

only the correct jack.  Do not 

force it. 

 
 

 

 

NOTE: Do not attempt to remove the controller from the housing.  Doing so could damage 

the digitizer and void your warranty. 

USB Connection 

The Roll-Up USB port connection is USB 1.1 and 2.0 compatible.  When the digitizer is 

connected to the USB port, Windows will recognize that there is a new device connected.  If 

Windows displays the Found New Hardware prompt, follow the onscreen instructions to 

complete the driver installation. 

1. Connect the interface cable to the USB jack on the Roll-Up III Connector Panel.  The 

connector is keyed and will fit only the correct jack.  Do not force it. 

2. Attach the other end of the USB cable to any one of the USB ports  on your 

computer or USB hub.  The digitizer will beep four short tones, indicating it is 

powered on.  View the Roll-Up III Tones for a complete table of the Roll-Up III tones. 

3. SuperSet Codes are not applicable when using the USB connection. 

NOTE: Power is supplied through the USB port.  No additional power source is needed for 

this installation. 
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RS-232 Serial Connection 

If your software application is not Wintab-compliant, be sure to set the correct two-digit 

Application SuperSet Code before connecting the serial cable to the computer.  SuperSet 

Codes can be found in Table 1.  If your application is not listed in Table 1, find the 

configuration settings that apply to your application in Table 2 and use the corresponding 

SuperSet Code.  If an appropriate SuperSet Code is not listed in Table 2, use the Custom 

Configuration Menu stored in the slot on the end of the Roll-Up III housing to configure 

your Roll-Up III. 

1. Plug the power supply into an AC outlet.  Connect the power supply to the 

appropriate jack on the Connector Panel.  The digitizer will beep four short tones 

(see the Roll-Up III Tones section for a complete table of Roll-Up III tones), indicating 

it is powered on. 

2. Connect the RS-232 serial cable to the serial jack on the Connector Panel.  The 

connector is keyed and will fit only the correct jack.  Do not force it. 

3. Configure the SuperSet Code.  The Roll-Up III comes from the factory with the 

SuperSet Code  pre-configured.  (See Using the SuperSet Menu.) 
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Using the SuperSet Menu 

The SuperSet Menu is the row of buttons printed in the lower left and upper right corners 

of the digitizer. 

 

The SuperSet Menu makes it possible to configure the Roll-Up III so that it sends the 

appropriate information for a serial connection to the software being used on your 

computer (see Table 1 section of this manual for an extensive list of digitizer software 

applications and their codes).  It is used to prepare the digitizer to receive specific, detailed 

custom configuration information from the Custom Configuration Menu for some serial 

installations.  In addition, the SuperSet Menu can be used for both serial and USB 

connection configurations, to set and change the digitizer orientation, and to turn the 

digitizer alarm off and on.  Use your stylus or cursor to click on the menu buttons to make 

your selections. 

The  menu button initiates Select Mode.  Two-digit numeric codes are entered after 

Select Mode is activated.  Most software supports Wintab using the TabletWorks drivers, 

whose SuperSet Code is  on the SuperSet Menu.  The Roll-Up III comes from 

the factory with the SuperSet Code  pre-configured. 

NOTE: Select Mode will not work with the USB interface.  USB talks to Wintab drivers 

exclusively. 
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The  menu button sets your preferred digitizer orientation.  The  button toggles 

the digitizer alarm off and on.  The  button activates the Custom Configuration menu. 

When using the SuperSet Menu, a tone will sound indicating a successful selection when 

you click on the   or  buttons.  Four tones will sound when you click on  or .  

(See the Roll-Up III Tones section for a complete table of the Roll-Up III tones.)  The number 

buttons  through  are active only after clicking on  for Select Mode. 

NOTE: Units built before October 8, 2014, have serial Plug-N-Play enabled for SuperSet 

Code .  On these units, use  instead of .  This SuperSet 

Code has the same settings, but Plug-N-Play is disabled. 

Changing the Digitizer’s Orientation 

Roll-Up III lets you choose between two different digitizer orientations: you can orient the 

digitizer with the controller Housing on your right (the factory default), or you can orient it 

with the Housing on your left. 

To change the orientation of the digitizer: 

1. Turn the digitizer to the desired orientation. 

2. Relocate the origin by clicking on the  button on the SuperSet Menu that is 

located in the lower left corner of the digitizer.  You will hear four short tones when 

you do this. 

NOTE: The orientation of the 20 x 24 Roll-Up III cannot be changed. 

Turning the Alarm Off and On 

You can disable the alarm if you do not want to hear a tone each time the transducer 

button is pressed.  When the alarm is off, you will still hear diagnostic and menu-related 

tones. 

To turn the alarm off or on: 

 Click on the  button – which toggles the tones on or off – on the SuperSet Menu. 
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NOTE: The following is relevant only for RS-232 serial installations.  USB does not require 

configuration. 

Configuring Your Roll-Up III for Specific Applications 

To configure your Roll-Up III for use with specific applications: 

1. In Table 1, find the application program you will be using with your Roll-Up III.  Note 

the corresponding SuperSet Code. 

 If your application program is not listed in Table 1, find the configuration 

settings in Table 2 that your application program requires and use the 

corresponding SuperSet Code. 

 If an appropriate SuperSet Code is not listed in Table 2, then use the Custom 

Configuration Menu (see the Using the Custom Configuration Menu section) to 

set up your Roll-Up III. 

2. On the SuperSet Menu, click on the  button, then click on the two digits of the 

SuperSet Code indicated for your application. 

You will hear four short tones after a successful menu configuration. 

Example: Configuring for a Specific Application 

Suppose you wanted to configure your Roll-Up III to operate with Autodesk’s AutoCAD 

application.  You would: 

1. Find the entry for AutoCAD in Table 1.  The SuperSet Code is 01. 

2. Click on the  button on the SuperSet Menu.  You will hear one short tone, 

indicating the digitizer is in Select Mode. 

3. Select the  button on the SuperSet Menu.  You will hear one short tone.  This 

enters the first digit of the SuperSet Code for AutoCAD. 

4. Click on the  button on the SuperSet Menu.  This enters the second digit of the 

SuperSet Code for AutoCAD. 

You will hear four short tones, indicating that the configuration is complete.  Roll-Up III is 

now configured to operate with AutoCAD.  Select Mode is no longer active.  You can begin 

digitizing. 
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NOTE: For more information about digitizer software application driver requirements, 

please go to the Technical Support section of the GTCO CalComp by Turning Technologies 

website. 

Table 1: SuperSet Menu Codes for Selected Applications 
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Table 2: Configuration Details for SuperSet Menu Codes 

NOTE: Max = 100 coordinates/second  

lpi = lines per inch lpmm = lines per millimeter 
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Roll-Up III Tones 

The Roll-Up III produces an alarm in the form of audio tones to inform you of various 

events.  The table below describes the kinds of tones you might her while operating the 

digitizer. 

Table 3: Roll-Up Tones 

 

*Configuration error tones or Diagnostics failed tones indicate a serious problem.  If 

you hear either of these tones, call GTCO CalComp by Turning Technologies Technical 

Support at 1.866.746.3015. 

NOTE: You might hear tones produced by the Roll-Up III which are actually sent by your 

application program.  (Programs can send commands to the digitizer to turn the audio tone 

generator on and off.)  If you hear tones during digitizing and they do not correspond to 

the tones listed in the table above, they are produced by the application program. 
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NOTE: This information applies to serial installations only. 

 

Introduction to the Custom Configuration Menu 

The Custom Configuration Menu is used to relay configuration information to the Roll-Up III 

in those cases where Table 1 and Table 2 do not supply the information or a SuperSet 

Menu Code for the graphic application software being used.  You will use the Custom 

Configuration Menu to configure the Roll-Up III for a specific baud rate, data format and 

other operating characteristics that your software requires for communication with the 

digitizer.  The Custom Configuration Menu is located in the slot at the end of the Roll-Up III 

housing. 

The configuration parameters for Roll-Up III are divided into three categories: 

 Communication Options 

 Output Format Options 

 Mode Options 

Communication Options 

 Baud: The rate, in bits/second, at which characters are transmitted across the RS-

232C serial interface.  Choices are: 1200, 2400, 4800, 9600, 19200 or 38400. 

 

 Data Bits: Data bits represent the actual data being sent from one device to 

another.  Both devices must be set for the same number of data bits.  Choices are: 

Seven (7) or Eight (8). 

 

 Stop Bits: Each character has one or two stop bits, which tell the receiving device 

that a character is complete.  The number of stop bits usually does not matter.  

Setting for two stop bits instead of one may overcome a mismatch in parity or data 

bits.  Choices are: One (1) or Two (2). 

 

 Parity: One bit can be allocated for parity (parity is a simple error-detecting 

scheme).  Both devices (sending and receiving) must be set for the same parity – 

either odd parity or even parity – or they must be set for no parity.  Choices are: 

None (N), Even (E) or Odd (O). 
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Output Format Options 

 GTCO: Selects GTCO-compatible formats.  See Advanced Programing Information in 

the Super L VI Online Help for greater detail on GTCO format structure.  Choices are: 

Binary or ASCII. 

 

 CalComp: Selects CalComp-compatible formats.  See Advanced Programming 

Information in the Super L VI Online Help for greater detail on CalComp format 

structure.  Choices are: Binary, ASCII 1, ASCII 2, ASCII 3 or ASCII 4. 

 

 Summa: Selects Summagraphics-compatible formats.  See Advanced Programming 

Information in the Super L VI Online Help for greater detail on Summagraphic format 

structure.  Choices are: Binary or ASCII. 

ASCII formats can be modified by including or excluding a button code, decimal point, 

carriage return or line feed, depending on whether GTCO, CalComp or Summa formats 

have been selected. 

Mode Options 

 Button: Defines whether the Pushbutton (Pb) value is included in the ASCII output 

report.  This option is available only with GTCO formats.  Choices are: Include or 

Exclude. 

 

 Space: Defines whether the Space (Sp) character (hex 20) is included in the ASCII 

output report as a delimiter between the X and Y coordinate values.  This option is 

available only in GTCO formats.  Choices are: Include or Exclude. 

 

 Decimal: Defines whether the period character (hex 2E) is included in the ASCII 

output report between the units and tenths digits.  This option is available only in 

Summagraphics formats.  Choices are: Include or Exclude. 

 

 Return: Defines whether the Carriage Return (CR) character (hex 0D) is included in 

the ASCII output report as a terminator.  This option is available in GTCO and 

Summagraphics formats.  Choices are: Include or Exclude. 

 

 Line Feed: Defines whether the Line Feed (LF) character (hex 0A) is included in the 

ASCII output report as a terminator.  This option is available in GTCO, CalComp and 

Summagraphics formats.  Choices are: Include or Exclude. 
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Mode Options 

 Mode: Defines how output reports are sent from the digitizer.  Choices are: Point, 

Line, Continuous, Line Incremental or Continuous Incremental. 

 

 Rate: Determines how fast output reports will be transmitted from the digitizer.  

Choices are: 12, 50 or 100 reports per second. 

 

 Resolution: The smallest reported value returned by the digitizer.  Choices are: 

1000 lpi, 2000 lpi, 4000 lpi, 40 lpmm, 100 lpmm or 150 lpmm. 

See the Advanced Programming Information section in the Super L VI Online Help at 

www.gtcocalcomp.com for more details. 

 

Using the Custom Configuration Menu 

If your application is not represented in the SuperSet Menu and does not have a SuperSet 

Code, or if a different configuration is required, you can use the Custom Configuration 

Menu to configure Roll-Up III.  The Custom Configuration Menu, pictured below, is stored in 

the slot at the end of the Roll-Up III housing.  The Custom Configuration Menu replaces the 

24 switches that were associated with older GTCO CalComp by Turning Technologies 

digitizers. 

 

http://www.gtcocalcomp.com/
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The configurations you set up can be stored for recall at a later time in any of the nine user-

definable SuperSet Menu locations – codes 90 through 98.  This allows the Roll-Up III 

configuration to be easily switched between applications, when you have such a 

requirement. 

To configure the Roll-Up III using the Custom Configuration Menu: 

1. Place the Custom Configuration Menu card, or the copy, anywhere in the active area 

of the digitizer.  The entire menu must be in the active area.  A piece of tape can be 

used to keep it in place during the configuration process. 

2. Click on the  button on the SuperSet Menu.  The alarm will beep slowly, 

indicating that the Custom Configuration Menu Mode is now ready to receive 

Alignment Point information. 

3. You will tell the Controller where the Custom Configuration Menu is physically 

located on the digitizer by clicking on the Alignment Points.  Click on Alignment Point 

1, the white dot in the small blue square labeled Point 1, in the lower left corner of 

the menu.  The alarm will beep rapidly, indicating that the system is waiting to 

receive Alignment Point 2. 

4. Click on Alignment Point 2, the white dot in the small blue square labeled Point 2, in 

the lower right corner of the menu.  After Alignment Point 2 is selected, the alarm 

will sound only if the transducer passes over an active block on the menu. 

NOTE: If invalid alignment points are selected, or if the menu is not entirely in the digitizer’s 

active area, the Custom Configuration Menu Mode will be aborted.  This is indicated by 

three medium tones from the alarm. 

5. Configure the Roll-Up III by selecting the function blocks that correspond to the 

settings your software will need to communicate with the digitizer. 

6. Review the configuration to ensure that the proper settings have been selected.  

Pass the transducer down each group of options; the alarm will sound when the 

transducer is over the active choice.  Some groups may be inactive, based on the 

options selected.  Click on a desired setting in a group to change it.  To cancel all 

settings, click in the active area outside the menu. 

7. When you have finished making your selections, you can save the configuration.  If 

you choose to save it temporarily, the configuration will be remembered only until 

another SuperSet Code is entered.  If you never change the configuration of your 

Roll-Up III from the custom one you just entered, the temporary configuration will 

always be used.  However, if you expect to be switching between configurations and 
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want to save the custom one for later recall, you can assign the configuration to a 

special user-definable SuperSet Code. 

 

 To save the configuration temporarily: 

 

Click on the  button on the SuperSet Menu.  You will hear four short tones to 

indicate you successfully saved the custom configuration.  The configuration is 

saved in a temporary location, where it will be retained even when the unit is 

powered off or reset.  However, if another SuperSet Code is entered, this temporary 

configuration is lost and cannot be recalled without configuring the Roll-Up III again. 

 

 To save the configuration in a user-definable location: 

 

As indicated in Table 2, the codes 90 through 98 are available as storage locations 

for user-defined custom configurations.  Simply click on the  button and select a 

two-digit number between 90 and 98.  Your custom configuration will be saved 

under that code number for future recall.  You will hear four short tones when you 

successfully save the custom configuration.  Saved configurations allow you to 

switch quickly between applications.  Storage locations 90 through 98 retain the 

saved configurations even when the Roll-Up III is turned off or reset. 

 

Care and Handling of Roll-Up III 

Roll-Up III was designed to be both portable and durable.  As with any product, it requires 

proper care and handling for reliable operation.  By following these recommendations, the 

Roll-Up III digitizer will provide you with many years of service: 

 Always use Roll-Up III on a flat surface, where no part of the unit is unsupported. 

 Before moving the digitizer, disconnect the transducer, interface cable and power 

supply, if connected. 

 Before moving the digitizer, roll it up.  The housing along the side of the digitizer is 

designed as a rolling aid and it allows you to easily control the rolling action.  (See 

the Transporting Roll-Up III section on the next page for specific moving instructions.) 

 Do not permanently attach anything to the digitizer. 

 Do not use sharp instruments on or near the Roll-Up III to avoid scratching or 

cutting it.  Cuts in the digitizer will void your warranty. 
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 Do not crease, dent or abuse the digitizer.  Creases can damage the digitizer 

structure.  Severe creases or abuse will void your warranty. 

 Clean Roll-Up III with any mild, nonabrasive household cleaner.  Rubbing alcohol is 

recommended.  Do not apply liquid directly to the surface of the Roll-Up III.  Spray 

the cleaning solution on a cloth and wipe it over the surface.  After cleaning, dry the 

surface to avoid possible digitizing errors. 

 

Transporting Roll-Up III 

You MUST transport Roll-Up III using the factory-supplied shipping materials – heavy gauge 

cardboard tube, insert and end caps.  Failure to do so could result in serious damage to the 

unit and may void your warranty. 

1. Disconnect the transducer and interface cable from the Roll-Up III and the 

computer.  Remove all material from the digitizer. 

2. Grasp the controller housing firmly with both hands and roll it toward the opposite 

side of the digitizer.  The housing and the printing on the digitizer surface must be 

on the inside of the roll.  The roll diameter should be just smaller than the inside 

diameter of the factory-supplied shipping tube.  When correctly rolled, only the 

digitizer’s black back will be exposed. 

 

3. Insert the rolled digitizer into the shipping tube and allow it to fully unroll against 

the inside of the tube.  Place the factory-supplied insert into the center of the rolled 

digitizer for support.   

4. Place the accessories in the accessory case and put it inside the hollow insert.  Set 

the factory-supplied end caps on the tube to seal it.  Place the tube in the optional 

Deluxe Travel Bag. 

NOTE: The Deluxe Travel Bag is intended to be used only in conjunction with the 

factory-supplied heavy gauge cardboard tube, insert and end caps.  The Deluxe Travel 

Bag does not provide complete protection if used alone.  The product will be subject to 

damage not covered by the warranty, if not protected by the tube, insert and end caps.  
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If you have misplaced or disposed of these items, contact GTCO CalComp by Turning 

Technologies (1.866.746.3015) for replacement parts. 

 

Troubleshooting Guide 

As with any computer peripheral, Roll-Up III problems sometimes do occur.  Most of 

these problems are easy to find and correct.  This troubleshooting guide provides clear 

instructions for finding and solving all common digitizer problems.  In most cases, you 

will be able to quickly take care of the problem yourself by following these steps: 

1. Install properly first. 

This troubleshooting guide assumes you have already correctly installed Roll-Up III 

according to the detailed instructions in the Setting Up Your Roll-Up III section.  If you 

have not followed the step-by-step instructions in that section, do so now. 

2. Work through the troubleshooting flowcharts on the following pages in this 

troubleshooting guide. 

 

Record any unusual observations.  Your notes will be useful if you need assistance 

from GTCO CalComp by Turning Technologies. 

  

3. If your system still does not work. 

 

Call our Technical Support Department at 1.866.746.3015.  Be prepared to discuss 

the observations you made while troubleshooting.  A Technical Support Specialist 

will help you resolve the problem as quickly as possible. 

NOTE: Refer to the Roll-Up III Tones table while using the Troubleshooting Guide. 

If you are experiencing erratic behavior with your digitizer, make sure that no conductive 

materials are being used.  This includes the graphite in pencil lead, some black plotter ink 

and digitizing on plastic or Mylar.  No electronic devices should be sitting on or near the 

digitizer, including keyboards, mice, calculators, etc.  If any of these describes normal 

working conditions, the Super L Series Digitizers would be more suited to your 

environment. 

NOTE: Tablet Not Found: If you are using a USB connection and the digitizer is not found, 

either disconnect or reconnect the USB cable, or restart the system. 
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Load Driver: if a window pops up telling you to load a driver every time you power on, and 

your application software does not use a driver, you should change the power on default 

SuperSet Code to , or load the driver from the TabletWorks CD. 

Procedure A: Begin Troubleshooting 

NOTE: This procedure should only be used to troubleshoot serial connections. 
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Procedure B: Troubleshooting 
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Using the Tablet Configuration Utilities 

If your application is not represented in the SuperSet Menu and does not have a SuperSet 

Code, or if a different configuration is required, you can use the Tablet Configuration 

Utilities to configure Roll-Up III.  The Tablet Configuration Utilities replace the 24 switches 

that were associated with older GTCO CalComp by Turning Technologies digitizers and the 

Custom Configuration Menu Card used with the Roll-Up II. 

To configure the Roll-Up III with the Tablet Configuration Utilities: 

1. Make sure the Roll-Up III is plugged into a Serial Port, powered on and all the tablet 

drivers have been uninstalled or disabled. 

2. Install the Tablet Configuration Utilities from the Select Utility Software to Install 

section on the TabletWorks CD, or download them from www.gtcocalcomp.com. 

3. After the installation has completed, run the Tablet Configuration Utilities from the 

Programs list under GTCO CalComp by Turning Technologies TCU. 

4. The Tablet Configuration Utilities will begin searching the Serial Ports for a 

supported tablet. 

a. If the tablet is found, information about the tablet will display under Device 

Info near the bottom of the screen. 

b. If the tablet is not found, a message will appear under Device Info near the 

bottom of the screen. 

i. If Wintab files were found, it’s possible that the TabletWorks driver 

has the Serial Port open. 

ii. If the Serial Port is open by another application, it will not be 

displayed under System Info.  Close any application, or uninstall any 

driver that is using the Serial Port and select Refresh System Info from 

the File dropdown list at the top of the screen.  Click on the Serial Port 

icon under System Info to search that Serial Port. 

NOTE: The Tablet Configuration Utilities can use the TabletWorks driver to test the tablet, 

but it must be communicating directly with the tablet, via the Serial Port, in order to 

configure it. 

5. Once the Roll-Up III has been located on a Serial Port, select Advanced Configuration 

from the Options dropdown list at the top of the screen. 

a. If Advanced Configuration is not an option, make sure Wintab Compatible 

Driver is not listed under Device Info. 
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6. Select a predefined, 01 through 55, SuperSet Code, or select one of the User 

Defined, 90 through 98, SuperSet Codes to customize. 

a. User Defined (90 through 98) SuperSet Codes are initially read from the 

tablet when the Advanced Configuration screen opens.  This is to prevent 

loss of custom settings.  Selecting Read Current Settings from the Options 

menu will: 

i. Read the Power-Up settings and User Defined SuperSet Codes from 

the tablet. 

ii. Overwrite all Custom Settings not yet saved to the tablet. 

b. Restore Factory Settings from the Options menu will prompt for: 

i. Power-Up settings reset to factory default and set current. 

ii. User Defined SuperSet Codes cleared and reset to factory default. 

7. After making your selections, choose one of the following from the File menu at the 

top of the screen. 

a. Save Temporary Settings will configure the tablet as shown until the tablet 

is powered off; reset or another SuperSet Code is selected. 

i. After saving temporary settings, select File/Exit to test with other 

applications.  This will leave the tablet configured to the temporary 

settings selected and close the Serial Port, enabling other applications 

to communicate with the tablet. 

b. Save Power-Up Settings will configure the tablet as shown.  Every time the 

tablet is powered off and back on, or reset, it will restore these settings. 

c. Save Custom Settings will reconfigure all nine of the tablet’s User Defined 

SuperSet Codes to the settings specified in the corresponding SuperSet Code 

dropdown list. 

i. You can click on the SuperSet Menu buttons on the tablet using the 

tablet’s cursor to activate these configurations: S plus 90 through 98. 

8. When you have finished, select Exit or Close from the File menu. 

a. Exit will close the Tablet Configuration Utilities. 

b. Close will exit the Advanced Configuration Screen and return to the Tablet 

Configuration Utilities window. 
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Regulatory Statements and Warranty 

Radio and Television Interference 

The user is cautioned that any changes or modifications not expressly approved by the 

party responsible for compliance could void the user’s authority to operate the equipment. 

This equipment has been tested and found to comply with the limits of a Class B digital 

device, pursuant to Part 15 of the FCC rules.  These limits are designed to provide 

reasonable protection against harmful interference in a residential installation.  This 

equipment generates, uses and can radiate radio frequency energy and, if not installed and 

used in accordance with the instructions, may cause harmful interference to radio 

communications.  However, there is no guarantee the interference will not occur in a 

particular installation.  If this equipment does cause harmful interference to radio or 

television reception, which can be determined by turning the equipment off and on, the 

user is encouraged to try to correct the interference by one or more of the following 

measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and the receiver. 

 Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 

 Reorient or coil cables. 

 Consult the dealer or an experienced Radio/TV technician for help. 

NOTE: Any cables the user adds to the device must be shielded to be in compliance with 

the FCC standards.  Any unauthorized modification to this device could result in the 

revocation of the end user’s authority to operate this device. 

Canada 

This digital apparatus does not exceed the Class B limits for radio noise emissions from 

digital apparatus as set out in the radio interference regulations of the Canadian 

Department of Communications. 

Le present appareil numérique n’emet pas bruits radioelectriques depassant 

les limites applicables aux appareils numériques de Classe B prescrites dans 

le réglement sur le brouillage radioelectrique edicte par le Ministere des 

Communications du Canada. 
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Japan 

 

Bescheinigung des Herstellers/Importeurs 

Heirmit wird bescheinigt, dass der/die/das 

3036R 

(Geraet, Typ, Bezeichnung) 

im Uebereinstimmung mit den Bestimmungen der 

Vfg 1046/1984 

(Amtsblattverfuegung) 

Funk-Entstort ist. 

Der Deutschen Bundespost wurde das Inverkehrbringen dieses Geraetes angezeigt und die 

Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt. 

 

GTCO CalComp, Inc. 

 

(Name des Herstellers/Importeurs) 

 

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen 

Anwendungsfall nachbildet, auf die Einhaltung der Funkentstoerbestimmungen geprueft. 

Es ist jodoch moeglich, dass die Funkentstoerbestimmungen unter unguenstigen 

Umstaenden bei anderen Geraetekombinationen nicht eingehalten werden. Fuer die 
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Einhaltung der Funk-entstoerbestimmungen seiner gesamten Anlage, in der dieses Geraet 

betrieben wird, ist der Betrieber verantwortlich. 

 

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte 

Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen ist der 

Betrieber verantwirtlich. 

 

European Union Emission Directive 

This product is in conformity with the protection requirements of EU Council Directive 

89/366/ECC on the approximation of the laws of the Member States relating to 

electromagnetic compatibility. 

This product has been tested and found to comply with the limits for Class B Information 

Technology Equipment according to CISPR 22/European Standard EN55022.  The limits for 

Class B equipment were derived for typical industrial environments to provide reasonable 

protection against interference with licensed communication devices. 

European Union WEEE Directive 

The manufacture of this equipment required the extraction and use of natural resources.  

It may contain hazardous substances that could impact health and the environment. 

 In order to avoid the dissemination of the hazardous substances into the 

environment and to diminish the pressure on our natural resources, GTCO CalComp 

by Turning Technologies encourages you to return this product to the appropriate 

take-back system facility.  These facilities reuse or recycle most of the materials in 

this equipment in a responsible way. 

 The crossed-out wheeled bin symbol below invites you to use these take-back 

systems. 

 If you need more information about the collection, reuse and recycling systems in 

your area, please contact your local or regional waste authority. 

 Further information about the responsible end-of-life management of this and other 

GTCO CalComp by Turning Technologies products is available on our website at 

www.gtcocalcomp.com. 
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Limited Warranty for Roll-Up III 

 

GTCO CalComp by Turning Technologies, Inc. warrants these products to be free from defects in 

material and workmanship under the following terms.  Complete and return the enclosed warranty 

registration card to ensure that your products are covered with this warranty. 

 

Coverage 

Parts and labor are warranted for two (2) years from the date of the first consumer purchase for the 

digitizer tablet, controller, transducers and tablet accessories.  Power supply and cables are also 

warranted for one (1) year.  This warranty applies to the original consumer purchaser only.   

 

Within the European Union, the warranty period is two (2) years, as mandated by the EU.  Contact 

your local dealer or distributor for additional warranty information. 

 

Warranty is only valid if original consumer’s purchase or lease date is less than or equal to six 

months from the original GTCO CalComp by Turning Technologies sale date.  This information will 

be captured by the system serial number and confirmed by the reseller’s purchase order. 

 

A nominal Warranty Handling Fee will be charged after the first 90 days of use and calculated from 

the date of original consumer purchase.  This payment may be made by Visa, MasterCard or 

American Express.  A copy of the sales receipt or invoice will be required for warranty verification. 

 

Conditions 

Except as specified below, this warranty covers all defects in material or workmanship in the 

products.  The following are not covered by the warranty: 

1. Any product on which the serial number has been defaced, modified or removed (if 

applicable). 

2. Damage, deterioration or malfunction resulting from: 

a. Accident, misuse, abuse, neglect, fire, water, lightning or other acts of nature, 

unauthorized modification for any purpose, unauthorized product modification, or 

failure to follow instructions supplied with the product. 

b. Repair or attempted repair by anyone not authorized by GTCO CalComp by Turning 

Technologies. 

c. Any damage in shipment of the product (claims must be presented to the carrier). 

d. Any other cause which does not relate to a manufacturing defect. 

3. Any product not sold or leased to a consumer within six months of GTCO CALCOMP BY 

TURNING TECHNOLOGIES original sale date. 

 

GTCO CalComp by Turning Technologies will pay all labor and material expenses for covered items, 

but will not pay for the following: 

1. Removal or installation charges. 
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2. Costs for initial technical adjustments (set up), including adjustment of user controls. 

3. Certain shipping charges.  (Payment of shipping charges is discussed in the next section of 

this warranty.) 

4. Packaging costs.  (Customers should keep their boxes.) 

 

Warranty Service Procedures 

1. To obtain service on your GTCO CalComp by Turning Technologies product, contact the 

Technical Support Department to receive a Return Material Authorization Number (RMA#) 

and shipping instructions by calling: 1-866-746-3015. 

2. Ship the product to GTCO CalComp by Turning Technologies with the RMA# marked clearly 

on the outside of the box.  Without a clearly marked RMA# on the shipping box, GTCO 

CalComp by Turning Technologies reserves the right to refuse the shipment. 

3. Although you must pay any shipping charges to ship the product to GTCO CalComp by 

Turning Technologies for warranty service, GTCO CalComp by Turning Technologies will pay 

the return shipping charges for ground shipment.  Other shipping options are available at an 

additional fee. 

4. Whenever warranty service is required, the original dated sales invoice (or a copy) must be 

presented as proof of warranty coverage and should be included in shipment of the product.  

Please also include your name, address, telephone number, fax number, email address and 

a description of the problem. 

5. If GTCO CalComp by Turning Technologies determines that the unit is not defective within 

the terms of the warranty, the consumer shall pay the cost of all freight charges, as well as 

any repair charges. 

 

Technical Support 

Web-based Technical Support is available free of charge at: www.gtcocalcomp.com, where current 

driver releases, as well as comprehensive technical support, troubleshooting, Technical Bulletins and 

FAQs can be found. 

 

Telephone Technical Support is available free of charge to the original consumer for a period of 90 

days from the date of purchase of the product.  Please contact our Technical Support Department 

at: 1-866-746-3015 or fax your request to: 480.998.1751.  

 

Disclaimer of Unstated Warranties 

The warranty printed above is the only warranty applicable to this purchase.  ALL OTHER 

WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  Assuming the 

warranty above stated is otherwise applicable, it is expressly understood and agreed that GTCO 

CalComp by Turning Technologies sole liability whether in contract, tort, under any warranty, in 

negligence or other shall be for the repair or replacement of the defective parts and under no 

circumstances shall GTCO CalComp by Turning Technologies be liable for special, indirect or 
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consequential damages.  The price stated and paid for the equipment is a consideration in limiting 

GTCO CalComp by Turning Technologies liability. 

 

Notice 

Some states and provinces do not allow the exclusion or limitation of incidental or consequential 

damages, so the above exclusion may not apply to you.  This warranty gives you specific legal rights, 

and you may have other rights, which vary from state to state, or province to province.   

 

To obtain service on your GTCO CalComp by Turning Technologies product, call our Technical 

Support Department at: 1-866-746-3015 or fax us at (480) 998-1751.  We can also be contacted 

through our website at www.gtcocalcomp.com (in US); at EUOffice@gtcocalcomp.com (in Germany); 

at infos@calcomp.fr (in France). 

 

Important! 

All products returned to GTCO CalComp by Turning Technologies for service must have prior 

approval in the form of a Return Merchandise Authorization Number (RMA#), which can be obtained 

by calling the Technical Support Department. 
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Corporate Headquarters 

14557 N. 82nd Street 

Scottsdale, Arizona 85260 

Tel: 1-866-746-3015 

Support: 1-866-746-3015 

Fax: 480-998-1751 
 

 

 

 

 

Copyright© 2014 GTCO CalComp by Turning Technologies, Inc. 
Roll-Up III is a trademark of GTCO CalComp by Turning Technologies, Inc. 

All other products and company names are the trademarks or registered trademarks of 
their respective owners. 

 
The information contained in this document is subject to change without notice. GTCO CalComp by 

Turning Technologies assumes no responsibility for technical, or editorial errors, or omissions that may 
appear in this document, or for the use of this material. Nor does GTCO CalComp by Turning 

Technologies make any commitment to update the information contained in this document.  This 
document contains proprietary information which is protected by copyright. All rights reserved. No part of 
this document can be photocopied or reproduced in any form without the prior, written consent of GTCO 

CalComp by Turning Technologies, Inc. 

 

 

 

 

 


